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Welcome to Web Access

Web Access is an ASP.NET 2.0 Web application allowing you to store, organize, and access your
organization’s information using a Web browser. You have complete control over the documents and
folders stored in your Laserfiche repository. Web Access also allows you to create, modify, or delete

content.

Username: I

Password: ]

Select the repository to log into from the available list

Repository: ] MyRepository
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Laserfiche Concepts

Repository:
A repository is a place where your files are stored. It contains your documents, organized within
folders, and additional information about those documents and folders.

Folder:
Folders aid the organization of your documents. They can contain imaged documents, electronic
documents, shortcuts, and other folders.

Imaged Document:
When you create a document by scanning or importing pages into the repository, you create an
imaged document.

Electronic Document:

An electronic document is a document that contains an electronic file, such as a Word document
or PDF. Electronic documents can contain searchable text and metadata, and they open in their
native applications through Web Access.

Document:

Web Access uses the term “document” to refer to an imaged document or an electronic document.

Field:
Fields contain additional information about the document that you can use for reference or search
and retrieval.

Template:
A collection of fields that can help categorize documents or folders.

Metadata:
Metadata is a general term used to refer to information associated with a document. Metadata
consists of field data, tags, version information, and linked documents.

Volume:
Volumes reflect the way the Laserfiche Server organizes and manages files. When you create or
import a document, you will specify the volume it will be stored in.

Briefcase:
A briefcase is a single file that contains exported Laserfiche documents and folders. Documents
will retain metadata, images, text, electronic files, and annotations.

Indicates new features in Web Access 8.



Getting Started

To view information stored in Laserfiche through a Web Access browser, you will need to open a
Laserfiche repository. If a repository has already been created and Web Access has been configured to
connect to it, it will be displayed on this Web Access Start Page. If you do not see a repository, contact

your administrator for help creating or connecting to a repository.

If a repository has been
previously created, it will be
listed in this drop-down menu.
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Repository: | MyRepository : _V_‘i|
Username: | |
Password: ’ —I
£ Juse Windows Authertication

You can log in using Windows
authentication or by specifying a
Laserfiche username and password.




Folder Browser

The Folder Browser is the main workspace where you can work with and find your organization's
information. The primary visual aspects in the Folder Browser are the toolbar and the panes.

Folder Pane Toolbar > Quick Search

f Lassrme:rngLAc 255 File » Export  Edit » Tasks « @ ADMIIESMyRepository | Settigys | Log Out
=1 § MyRepostory SAF |, Current Folder |
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B For more information about the toolbar and panes, see User Interface in the Web Access help files.




Double-click a document
icon to open the file. -

[ Current Folder |
> [E | Bhalgx®e [Search repository.. | 9] ~] ¥
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2 Delete frack
i Import...
<> Scan... -
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[2d Access Rights... Cription Web Access.
| lﬂ. Elroiemes k form

B For more information on e-mailing documents from Web Access, see Sending Documents via E-Mail in the Web
Access help files.




Searching

After storing your documents, you can retrieve them by using one of a variety of search types, or you can
use the Quick Search in the Folder Browser to perform searches quickly without expanding the Search
Bar.

Quick Search
Search the full Click to toggle the
text of documents. display of the Search Bar.
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Frequently Used Search Types

,Q, Customize Search v Search within entire repository v View Advanced Search
Last Modified  [Today M 0
Created Today - L7
Since Yesterday
This week
Within last 2 weeks
:rh;;'n‘r:tthz i Search by modification or
In i months N
Siiaat creation date.
Exactly
Before
After
Between
J4 Customize Search v Search within entire repository v View Advanced Search
Checked Out By | j' (2]
Created By | = (7]
] .
Owned By 1 1 @

Search for entries checked
out, created, or owned by a
specific user.

View Advanced Search

View or modify Advanced
Search syntax.

B For more information about searching, see Searching in the Web Access help files, or search
support.laserfiche.com.




Document Viewer

The Document Viewer allows you to view your document’s images, text, thumbnails, and field data. With
sufficient privileges and security rights, you can make changes to a document, apply annotations, set field
data, modify the text associated with each page, and manage the pages in the document.

Metadata Pane _ Image Pane Text Pane
Add additional information The document Add or modify
to organize your image. searchable text.
documents.
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Thumbnail Pane Breadcrumb Navigation
View pages at a Links are provided to each previous
smaller scale for folder you navigated through to get

easier navigation. to your current location. ‘
I




Document Viewer Toolbar

The Document Viewer toolbar allows you to perform basic operations, such as adding image and text
annotations, zooming in and out of the image, and determining what type of information is displayed.

Panning Tool Add Sticky Note
Scroll and drag
your image.

Scan Add Highlights

Ml

BBaveI-éLH@{"?,,% I

Zoom Tool Add Stamp
Selection Tool Add Redactions
Search Document
Search for text in the
open document. .
Metadata Image First/Last Page Zoom In/Out
Pane Pane

|
L_@@ =, K 4] Page of 2 p PPl (5| Fitwidth (/| S0

1
| | - | I_I_
Thumbnail Text | Jump to Rotate Image

Pane Pane Previous/Next Page specific page Counterclockwise
and Clockwise

B For more information about the Document Viewer and Toolbar, see User Interface in the Web Access help files.



Importing

Any file can be imported into a Laserfiche repository. For example, you can import previously scanned
images, PDFs, Word documents, and other electronic files. When importing files, you can set basic
document properties, such as the name of the document, the folder where it will be stored, and field
data. You can also send documents from Microsoft Office and Windows Explorer directly to a Laserfiche

repository.

Assign field and

Click File, Import
to import a file.

Export + Edit «

| New Folder
= New Shortcut
L] New Document

e
b3l

— ETT—

< Scan...

Print List Contents

[J Fields...

|5] Properties

[gd Access Rights...

Name your Choose where to
document. store your document.
Importing [My Doc] {(1/1)

Name: Iluhf Document

comerss| oo il

tag information.

Decide if you want
text extracted from
electronic files.

[My Repositoryt |(Browee... ]
Volume:
| <Use parent folder's default volume> V_,]
] Extract text from electronic files.
Status:
| Next |[ cancel |




Microsoft Office Integration

Office 2003 Outlook
[~ Inbox - Microsoft Outlook
 File |t View Go Tools
i Mew »
1 Open »
- Closg All Items
U savess..
Send to Laserfiche
Save Attachments »
8= Fotger ]
Data Fil:- I;nglmzrll_.. .
Import and Export...
‘Web Page Preview Aschive...
o oo seuw.. l Pagesetwy b
g Prink Preview [, Print Preview
| Erint... kP & print. Ctr+p
Send To * | 3| maid Recipient ;m:u_&_mge Mode b |
Properties pol| Mad Regipient (for Review)... Work Offine
1 T\ \Client-Server Overview and Con... Maill Recipient (as Attachment)... r T &
2 CH\...\Chient-Server Overview and Con... 2l Routing Recipient...
3T:\...\Chent-Server Overview and Con... )| Exchange Folder...
4 C:\,..\Chent-Server Overview and Con... B Oriine Meeting Participant
Exit ¢ ; Redipiert using a Fax Modem...
: Redipient using Internet Fax Service...
= Microsoft Office PowerPoint
Laserfiche  p
Office 2007
SO LF Y E My Document - Microsoft Word
*j;:;;; o S TN Send Microsoft Office and
o Microsoft Outlook files directly
=] Send s copyofthe documert in 0 ¢-man to a Laserfiche repository.

m Use an Internet fax service to fax the
‘document.

Laserfiche
Archive the current to

3] Print  » G LaserFiche Office Add-in
Press F1 for more help.

I [_j" Qlose

[ wora options | [ X Estwora |

|
r
|

A e T
P i T R e




Exporting

You can export images, text, briefcases, electronic documents, folder contents lists, and search results.

Click Export and select
what you want to export.

Password protect images
exported as PDFs.

l__m Edit v Tasks ~ I_ PDF Expoit Options u_

1 DR 3 pemT
=] Images... ®an e
-'lj Tex.. O Pages: -
(! Erter page ranges like this: 1-5,8,10,12-14
Eﬁgrlefcase...

List Contents... Enable Document Security

! Password to view PDF: [Fre+s

Repeat password: ikl R

Select Images under Export in the Settings
dialog box to select the default file format you
want images exported to.

You can also choose how you (
want annotations exported,
as well as file format options.

Export | [ cCancel ]

Settings <
Browser :
Entry Display Ex_p brt Settings: Images
Browser Columns ;
Recycle Bin Columns Defaglt image format
Toolbar
Search Imagg format: =
Options PDF (color/grayscale) “\_r__]
Results Display
Columns — Annotations and redactions
Document Viewer |7
Options [ include redactions on exported images
Toolbar [“linclude all other annotations on ex
MetadatsTadiber on exported images
e — ] T
ll-'llmN 2 Export multiple images from a document as a multi-page TIFF file (when
Et-:‘l gj]ammg exporting as TIFF)
Brigfeasas [“l convert annotations into PDF annotations
New Documenis
Autoname
Defaults
File Conversion
Account
Password
[ save || cancel |

B For more information about importing and exporting documents, see Creating Documents and Exporting in the
Web Access help files, or search support.laserfiche.com.



Printing

Printing in Web Access is done through each document’s native application.

L File Edt View Document Comments Tools
Advanced Window Help

@ Adobe Acrobat Standard - [Docume... (= (3]

-2 X

:% ?3 [E] Li_:J %v (ﬁ" %] §1 search

Docuiment Management Overview

[+ |

To print an electronic document,
right-click it, point to Open and
select Electronic Document. Print
it from its native application.
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export it, for instance, to a PDF
or TIFF, open it in its native
application, and print it using
that application.
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Annotations

A wide variety of annotations can be applied to your documents, some to either an image or text and
others only to an image. Text can be added to a document in the Text Pane.

[ Text Box > Attachment
(= Current Folder U' Julius Caesar (3} |
Blsave | 2| R M A7 /& “Searcb .»e_;;ﬁartpfy.. [2]+] »
(G S0 & KA Pagel 1 Joro0 b I O Fitwidth| ~I|® O
~ -~
Highlight i |
- JULIUS CAESAR
Redaction — 1 ss— | -
Mk a Akssk g ARk H_‘h 1 nn ES QR (GaESuR:)
= Stnkethmugh e L ST TR PSR i
SLARCLS ANTONILS (ANTONY | ey afn Sl of Rl Cassas _:| gm%m(_gcwm
[ Underline ——— a5 s, | MARGUS-ANTOMUS-(ANTONY
[ Rectangle — | :
' | triumvirs after death of Julius [Caes:
. !
[» Callout Text — — : i
TRE R & 1
LIGAams s bebpraareloy phng
(LR RS NIEY M‘ AEMILIUS
LURTENTRYRLT ) [ ={ o [ T (R B ={ i [ [ TR [ B § i :
c v |4 il | 3
|Z) myRepository » | Documents » 5 Willia » Tragedies b Julius Caesar
1135, 0]14% (Fit-to-Widith) | Image: 2960 x 3300
[ Line [ Image
> Freehand
To edit text, right-click in the tad
Text Pane and select Edit Text. JULIUS CAESAR =
| am editing text. W

DRAMATIS PERS!




Metadata

Metadata is information associated with a document and consists of fields, tags, links, and versions.
_Metadata helps you organize and find documents and folders.

Select a

template.

[ Current Folder “ Julius Caesa)

Select a tag to add to your document.

[ save ] Ui Revert “Seam’: rephsitony... l p] -1 =)
Template: | Tags ]
| Library Documents vl
[ E3:My Informational Tag
Title

Julius Caesar

Add Remove Field(sh..

Author

[Shakespeare ]
Date

07/02/2008 12:00:00 AM [:: [N

= [%i My Security Tag

| Linked Documents ‘l—

Attachment: E] Antony and Cleopatra (Message) -
Remove

My Repository\General Documents'5 William
Shakespeare\Tragedies Antony and Cleog

Add Linked Document...

—l—vel sions

Version1- |=] Julius Caesar

ADMIN - 4/22/98 12:42 A - My Repository\General
D \S William Shakespeare\Tragedies.Julius Caesar
Details - Remove

Add Version... Import Version...

=] Metadata fdr MyRepositorv b General Documents »

5 William Shakespeare » Tragedies » Julius Caesar

Displaying metadata for entry

2> Add or remove fields without

associating them with a
template.

Create, import, delete, Link to or delete a link
and view versions of a to another document in
document. the repository.

B For more information about annotations and assigning information to documents, see Viewing and Modifying
Documents, Assigning Information to a Document, and Fields in the Web Access help files, or search

support.laserfiche.com.



Moving Pages and Documents

Pages can be rearranged within a document, and documents themselves can be moved to new locations
in the repository.

Thumbnails

Rearrange pages by
dragging the thumbnail
to the new location.

Page 11 Page 12 Page 13 Page 14 Page 15

l» Export vl;ﬂ. Tasks ~
— | of cut
[ Current [ Copy
>8[®|C =
TS L o [indexed
Yes
To move a document . Move lo Folder Ves
to a different location,
L | | Guotations, Qu d Humor
select it in the Folder — s Smen Yes

Browser and select | E Declaration of Independence
Move to Folder from
the Edit menu.

@ For more information on moving pages and documents, see Working with Documents and Viewing and Modifying
Documents in the Web Access help files.



Scanning: Basic Mode

One way to bring documents into a repository is by using Laserfiche Scanning. You can scan images,
perform image processing, and create standard documents from processed images. Basic mode provides a
fast and simple interface requiring minimal conflguratlon

Click the Scan button on

I — the Folder Browser toolbar.
>0|BBa g X
Please selectthe scanning mode i
Choose a layout for scanning images:
@Basic———— )
[ Choose the desired
O Standard scanning mode.
L_oK ][ cancel |
Transportation in the 20T mi i yan s ints |ﬁe|d5| Tags Settings
Philippines et e g 1 s ' ~
b s —— '_ . Wapached D Bere shung rmom b mare =
W e T !
m::ﬂ o ol 4% 00 8 Iy i Wy By b s i st oy faall | e — e
e gty e by pocked rafe dgn s =1
Far - - ey qw“-;rp-umuulw = cat
T omtrn Bt B Al e e I egory;
{Transportation [ i
Date 3
0470372008 |
Subject
e =|  [Phippines |
L sl -
e e g 3
R L s | sdteende v s __Lseff cran | &
g e o fas Barhees i o Db i B Y e = Mweﬂpbons:
| #naagh g by sbondt 1 paagle e @ maniet ¥ dowin imaly bt s pt thet Is
| wvery toing of Pu rarfow e b e e wvwpny Feg r B 2yt
ks P b g, st & doiwm ot o8l o 8 g0 [} Lregle Docume
e e e & stoe
r':::b_“_'"m* o by st o} u-b--p mhc:?-; v
q of 4
'R AR Y F——
For Help, press F1 Page 1of 4 Imade: 2560 x 3300, 300 X 300 DPI

Scanned image The properties associated
with the scanned document.



Scanning: Standard Mode

Standard mode offers all the features of Basic Mode, plus the ability to perform advanced image enhancements, scan
multiple documents, customize the organization and storage of documents, and configure default document properties
to be applied to future documents. ' '

Image enhancements and The properties associated
processes assigned to the with the scanned document.
scanned document.

= Myl aserficheReository - Laserfiche Scanning

Transporiation in the

[Fieids | Tags _settings

:
i
i
i

it et bt
e e i

P

ot oypuisty
i bl e TR, Wiy At e 6t o
-y

e
[ et ey
-

|=-:-..'-.'l'“--..-.f‘g e

| ) Create Docue
M.I {44 Move to New Folder
ol . Jact | (3 Store

Scanned [ Thumbnail Image enhancements — | ¢l Resize
images Pane and processes D Rolate
[\ Smooth
6% OmviPage OCA
{ﬁ Page Removal

B For more information on scanning, see Web Scanning in the Web Access help files or search
support.laserfiche.com.




DISCLAIMER

Compulink Management Center, Inc. makes no representations or warranties with respect to the contents or
use of this manual, and specifically disclaims any express or implied warranties, merchantability or fitness
for any particular purpose. Furthermore, Compulink Management Center, Inc. reserves the right to revise this
publication and to make changes to its content, at any time, without obligation to notify any person or entity of
such revisions or changes.
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